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POSSIBILITY OF SUCH DAMAGE.
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7z.dll: GNU LGPL + unRAR restriction, All other files: GNU LGPL. 7-zip License: This library
is free software; you can redistribute it and/or modify it under the terms of the GNU
Lesser General Public License as published by the Free Software Foundation; either
version 2.1 of the License, or (at your option) any later version. This library is distributed
in the hope that it will be useful,but WITHOUT ANY WARRANTY; without even the implied
warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU
Lesser General Public License for more details. You should have received a copy of the
GNU Lesser General Public License along with this library; if not, write to the Free
Software Foundation, Inc., 59 Temple Place, Suite 330, Boston, MA 02111-1307 USA.
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MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU Lesser
General Public License for more details. You should have received a copy of the GNU
Lesser General Public License along with this library; if not, write to the Free Software
Foundation, Inc., 51 Franklin St, Fifth Floor, Boston, MA 02110-1301 USA Permission is
hereby granted to use or copy this program under the terms of the GNU LGPL, provided
that the Copyright, this License, and the Availability of the original version is retained on
all copies.User documentation of any code that uses this code or any modified version of
this code must cite the Copyright, this License, the Availability note, and "Used by
permission." Permission to modify the code and to distribute modified code is granted,
provided the Copyright, this License, and the Availability note are retained, and a notice
that the code was modified is included. AMD Availability:
http://www.cise.ufl.edu/research/sparse/amd
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UMFPACK Copyright: UMFPACK Copyright © 1995-2006 by Timothy A. Davis. All Rights
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but WITHOUT ANY WARRANTY; without even the implied warranty of MERCHANTABILITY
or FITNESS FOR A PARTICULAR PURPOSE. See the GNU Lesser General Public License for
more details. You should have received a copy of the GNU Lesser General Public License
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program under the terms of the GNU LGPL, provided that the Copyright, this License, and
the Availability of the original version is retained on all copies. User documentation of any
code that uses this code or any modified version of this code must cite the Copyright, this
License, the Availability note, and "Used by permission." Permission to modify the code
and to distribute modified code is granted, provided the Copyright, this License, and the
Availability note are retained, and a notice that the code was modified is included.
UMFPACK Availability: http://www.cise.ufl.edu/research/sparse/umfpack  UMFPACK
(including versions 2.2.1 and earlier, in FORTRAN) is available at
http://www.cise.ufl.edu/research/sparse . MA38 is available in the Harwell Subroutine
Library. This version of UMFPACK includes a modified form of COLAMD Version 2.0,
originally released on Jan. 31, 2000, also available at
http://www.cise.ufl.edu/research/sparse . COLAMD V2.0 is also incorporated as a built-in
function in MATLAB version 6.1, by The MathWorks, Inc. http://www.mathworks.com .
COLAMD V1.0 appears as a column-preordering in SuperLU (SuperLU is available at
http://www.netlib.org ). UMFPACK v4.0 is a built-in routine in MATLAB 6.5. UMFPACK v4.3
is a built-in routine in MATLAB 7.1.

Qt Version 4.6.3 - Qt Notice: The Qt code was modified. Used by permission. Qt copyright:
Qt Version 4.6.3, Copyright (c) 2010 by Nokia Corporation. All Rights Reserved. Qt
License: Your use or distribution of Qt or any modified version of Qt implies that you agree
to this License. This library is free software; you can redistribute it and/or modify it under
the
terms of the GNU Lesser General Public License as published by the Free Software
Foundation; either version 2.1 of the License, or (at your option) any later version. This
library is distributed in the hope that it will be useful,
but WITHOUT ANY WARRANTY; without even the implied warranty of MERCHANTABILITY
or FITNESS FOR A PARTICULAR PURPOSE. See the GNU Lesser General Public License for
more details. You should have received a copy of the GNU Lesser General Public License
along with this library; if not, write to the Free Software Foundation, Inc., 51 Franklin St,
Fifth Floor, Boston, MA 02110-1301 USA Permission is hereby granted to use or copy this
program under the terms of the GNU LGPL, provided that the Copyright, this License, and
the Availability of the original version is retained on all copies.User
documentation of any code that uses this code or any modified version of this code must
cite the Copyright, this License, the Availability note, and "Used by permission."
Permission to modify the code and to distribute modified code is granted, provided the
Copyright, this License, and the Availability note are retained, and a notice that the code
was modified is included. Qt Availability: http://www.qtsoftware.com/downloads  Patches
Applied to Qt can be found in the installation at:
$HPEESOF_DIR/prod/licenses/thirdparty/qt/patches. You may also contact Brian
Buchanan at Agilent Inc. at brian_buchanan@agilent.com for more information.

The HiSIM_HV source code, and all copyrights, trade secrets or other intellectual property
rights in and to the source code, is owned by Hiroshima University and/or STARC.

Errata The ADS product may contain references to "HP" or "HPEESOF" such as in file
names and directory names. The business entity formerly known as "HP EEsof" is now part
of Agilent Technologies and is known as "Agilent EEsof". To avoid broken functionality and
to maintain backward compatibility for our customers, we did not change all the names
and labels that contain "HP" or "HPEESOF" references.

Warranty The material contained in this document is provided "as is", and is subject to
being changed, without notice, in future editions. Further, to the maximum extent
permitted by applicable law, Agilent disclaims all warranties, either express or implied,
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with regard to this documentation and any information contained herein, including but not
limited to the implied warranties of merchantability and fitness for a particular purpose.
Agilent shall not be liable for errors or for incidental or consequential damages in
connection with the furnishing, use, or performance of this document or of any
information contained herein. Should Agilent and the user have a separate written
agreement with warranty terms covering the material in this document that conflict with
these terms, the warranty terms in the separate agreement shall control.

Technology Licenses The hardware and/or software described in this document are
furnished under a license and may be used or copied only in accordance with the terms of
such license. Portions of this product include the SystemC software licensed under Open
Source terms, which are available for download at http://systemc.org/ . This software is
redistributed by Agilent. The Contributors of the SystemC software provide this software
"as is" and offer no warranty of any kind, express or implied, including without limitation
warranties or conditions or title and non-infringement, and implied warranties or
conditions merchantability and fitness for a particular purpose. Contributors shall not be
liable for any damages of any kind including without limitation direct, indirect, special,
incidental and consequential damages, such as lost profits. Any provisions that differ from
this disclaimer are offered by Agilent only.

Restricted Rights Legend U.S. Government Restricted Rights. Software and technical
data rights granted to the federal government include only those rights customarily
provided to end user customers. Agilent provides this customary commercial license in
Software and technical data pursuant to FAR 12.211 (Technical Data) and 12.212
(Computer Software) and, for the Department of Defense, DFARS 252.227-7015
(Technical Data - Commercial Items) and DFARS 227.7202-3 (Rights in Commercial
Computer Software or Computer Software Documentation).
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 Measurement Results for Expressions
for UWB Wireless Test Benches
Measurement results from a wireless test bench have associated names that can be used
in Expressions. Those expressions can further be used in specifying goals for Optimization
and Monte Carlo/Yield analysis. For details on using expressions, see the Measurement
Expressions (expmeas) documentation. For details on setting analysis goals using
Optimization and Monte Carlo/Yield analysis, see the Tuning, Optimization, and Statistical
Design (optstat) documentation.

You can use an expression to determine the measurement result independent variable
name and its minimum and maximum values. The following example expressions show
how to obtain these measurement details where MeasResults is the name of the
measurement result of interest:

The Independent Variable Name for this measurement result is obtained by using the
expression
indep(MeasResults)

The Minimum Independent Variable Value for this measurement result is obtained by
using the expression
min(indep(MeasResults))

The Maximum Independent Variable Value for this measurement result is obtained by
using the expression
max(indep(MeasResults))

The following three tables list the measurement result names and independent variable
name for each test bench measurement. Expressions defined in a MeasEqn block must use
the full Measurement Results Name listed. Expressions used in the Data Display may omit
the leading test bench name. You can also locate details on the measurement result
minimum and maximum independent variable values by

Referring to the measurement parameter descriptions when they are available (not
all measurement parameter descriptions identify these minimum and maximum
values).
Observing the minimum and maximum independent variable values in the Data
Display for the measurement.

 

 UWB_TX Measurement Results
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Measurement Results Name Independent Variable Name

Envelope

UWB_TX.RF_V time

UWB_TX.Meas_V time

Constellation

UWB_TX.RF_EVM.RxConstellation Index

UWB_TX.RF_EVM.TxConstellation Index

UWB_TX.Meas_EVM.RxConstellation Index

UWB_TX.Meas_EVM.TxConstellation Index

Power

UWB_TX.RF_Power.MeanPower_dBm Index

UWB_TX.RF_Power.CCDF Index

UWB_TX.RF_Power.PeakPower_dBm Index

UWB_TX.RF_Power.SignalRange_dB Index

UWB_TX.Meas_Power.MeanPower_dBm Index

UWB_TX.Meas_Power.CCDF Index

UWB_TX.Meas_Power.PeakPower_dBm Index

UWB_TX.Meas_Power.SignalRange_dB Index

Spectrum

UWB_TX.RF_Spectrum freq

UWB_TX.Meas_Spectrum freq

UWB_TX.RF_Spectrum3960 freq

UWB_TX.Meas_Spectrum3960 freq

EVM

UWB_TX.RF_EVM.EVM Index

UWB_TX.Meas_EVM.EVM Index

 

 UWB_Rx_Sensitivity Measurement Results

Measurement Results Name Independent Variable Name

RX Sensitivity

UWB_Rx_Sensitivity.B1.BER Index

UWB_Rx_Sensitivity.B1.FER Index

 

 UWB_Rx_Performance_11a_Interference Measurement Results
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Measurement Results Name Independent Variable Name

RX Sensitivity

UWB_Rx_Sensitivity.B1.BER Index

UWB_Rx_Sensitivity.B1.FER Index
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 RF DUT Limitations for UWB Wireless
Test Benches
This section describes test bench use with typical RF DUTs, improving test bench
performance when certain RF DUT types are used, and improving simulation fidelity. Two
sections regarding special attention for Spectum and EVM transmission measurements is
also included.

The RF DUT, in general, may be a circuit design with any combination and quantity of
analog and RF components, transistors, resistors, capacitors, etc. suitable for simulation
with the Agilent Circuit Envelope simulator. More complex RF circuits will take more time
to simulate and will consume more memory.

Test bench simulation time and memory requirements can be considered to be the
combination of the requirements for the baseline test bench measurement with the
simplest RF circuit plus the requirements for a Circuit Envelope simulation for the RF DUT
of interest.

An RF DUT connected to a wireless test bench can generally be used with the test bench
to perform default measurements by setting the test bench Required Parameters . Default
measurement parameter settings can be used (exceptions described below), for a typical
RF DUT that:

Requires an input (RF) signal with constant RF carrier frequency.
The test bench RF signal source output does not produce an RF signal whose RF
carrier frequency varies with time. However, the test bench will support an output
(RF) signal that contains RF carrier phase and frequency modulation as can be
represented with suitable I and Q envelope variations on a constant RF carrier
frequency.
Produces an output (Meas) signal with constant RF carrier frequency.
The test bench input (Meas) signal must not contain a carrier frequency whose
frequency varies with time. However, the test bench will support an input (Meas)
signal that contains RF carrier phase noise or contains time varying Doppler shifts of
the RF carrier. These signal perturbations are expected to be represented with
suitable I and Q envelope variations on a constant RF carrier frequency.
Requires an input (RF) signal from a signal generator with a 50-ohm source
resistance. Otherwise, set the SourceR parameter value in the Basic Parameters tab.
Requires an input (RF) signal with no additive thermal noise (TX test benches) or
source resistor temperature set to 16.85 o C (RX test benches). Otherwise, set the
SourceTemp (TX and RX test benches) and EnableSourceNoise (TX test benches)
parameters in the Basic Parameters tab.
Requires an input (RF) signal with no spectrum mirroring. Otherwise, set the
MirrorSourceSpectrum parameter value in the Basic Parameters tab.
Produces an output (Meas) signal that requires a 50-ohm external load resistance.
Otherwise, set the MeasR parameter value in the Basic Parameters tab.
Produces an output (Meas) signal with no spectrum mirroring. Otherwise, set the
MirrorMeasSpectrum parameter value in the Basic Parameters tab.
Relies on the test bench for any measurement-related bandpass signal filtering of the
RF DUT output (Meas) signal.

When the RF DUT contains a bandpass filter with bandwidth that is on the order
of the test bench receiver system (~1 times the test bench receiver bandwidth)
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and the user wants a complete characterization of the RF DUT filter, the default
time CE_TimeStep must be set smaller.
When the RF DUT bandpass filter is much wider than the test bench receiver
system (>2 times the test bench receiver bandwidth), the user may not want to
use the smaller CE_TimeStep time step to fully characterize it because the user
knows the RF DUT bandpass filter has little or no effect in the modulation
bandwidth in this case.

 

 Improving Test Bench Performance

This section provides information regarding improving test bench performance when
certain RF DUT types are used.

Analog/RF models (TimeDelay and all transmission line models) used with Circuit
Envelope simulation that perform linear interpolation on time domain waveforms for
modeling time delay characteristics that are not an integer number of CE_TimeStep
units. Degradation is likely in some measurements, especially EVM.
This limitation is due to the linear interpolation between two successive simulation
time points, which degrades waveform quality and adversely affects EVM
measurements.
To avoid this kind of simulator-induced waveform quality degradation: avoid use of
Analog/RF models that rely on linear interpolation on time domain characteristics; or,
reduce the test bench CE_TimeStep time step by a factor of 4 below the default
CE_TimeStep (simulation time will be 4 times longer).
Analog/RF lumped components (R, L, C) used to provide bandpass filtering with a
bandwidth as small as the wireless signal RF information bandwidth are likely to
cause degradation in some measurements, especially Spectrum. These circuit filters
require much smaller CE_TimeStep values than would otherwise be required for RF
DUT circuits with broader bandwidths.
This limitation is due to the smaller Circuit Envelope simulation time steps required to
resolve the differential equations for the L, C components when narrow RF
bandwidths are involved. Larger time steps degrade the resolution of the simulated
bandpass filtering effects and do not result in accurate frequency domain
measurements, especially Spectrum and EVM measurements (when the wireless
technology is sensitive to frequency domain distortions).
To determine that your lumped component bandwidth filter requires smaller
CE_TimeStep, first characterize your filter with Harmonic Balance simulations over
the modulation bandwidth of interest centered at the carrier frequency of interest.
Though it is difficult to identify an exact guideline on the Circuit Envelope time step
required for good filter resolution, a reasonable rule is to set the CE_TimeStep to
1/(double-sided 3dB bandwidth)/32.
To avoid this kind of simulator-induced waveform quality degradation, avoid the use
of R, L, C lumped filters with bandwidths as narrow as the RF signal information
bandwidth, or reduce the CE_TimeStep.
Analog/RF data-based models (such as S-parameters and noise parameters in S2P
data files) used to provide RF bandpass filtering with a bandwidth as small as 1.5
times the wireless signal RF information bandwidth are likely to cause degradation in
some measurements, especially EVM.
This limitation is due to causal S-parameter data about the signal carrier frequency
requiring a sufficient number of frequency points within the modulation bandwidth;
otherwise, the simulated data may cause degraded signal waveform quality. In
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general, there should be more than 20 frequency points in the modulation
bandwidth; more is required if the filter that the S-parameter data represents has
fine-grain variations at small frequency steps.
To avoid this kind of simulator-induced waveform quality degradation, avoid the use
of data-based models with bandwidths as narrow as the RF signal information
bandwidth, or increase the number of frequency points in the data file within the
modulation bandwidth and possibly also reduce the CE_TimeStep simulation time
step.
An additional limitation exists when noise data is included in the data file. Circuit
Envelope simulation technology does not provide frequency-dependent noise within
the modulation bandwidth for this specific case when noise is from a frequency
domain data file. This may result in output noise power that is larger than expected;
if the noise power is large enough, it may cause degraded signal waveform quality.
To avoid this kind of simulator-induced waveform quality degradation avoid the use
of noise data in the data-based models or use an alternate noise model.

 

 Improving Simulation Fidelity

Some RF circuits will provide better Circuit Envelope simulation fidelity if the CE_TimeStep
is reduced.

In general, the default setting of the test bench OversamplingRatio provides
adequate wireless signal definition and provides the WTB_TimeStep default value.
Set CE_TimeStep = 1/Bandwidth/OversampingRatio/N
where N is an integer ≥ 1
When CE_TimeStep is less than the WTB_TimeStep (i.e., N>1), the RF signal to the
RF DUT is automatically upsampled from the WTB_TimeStep and the RF DUT output
signal is automatically downsampled back to the WTB_TimeStep. This sampling
introduces a time delay to the RF DUT of 10×WTB_TimeStep and a time delay of the
measured RF DUT output signal of 20×WTB_TimeStep relative to the measured RF
signal sent to the RF DUT prior to its upsampling.

 

 Special Attention for Spectrum Measurements

The Spectrum Measurement spectrum may have a mask against which the spectrum must
be lower in order to pass the wireless specification. The Spectrum measurement itself is
based on DSP algorithms that result in as much as 15 dB low-level spectrum variation at
frequencies far from the carrier.
To reduce this low-level spectrum variation, a moving average can be applied to the
spectrum using the moving_average(<data>, 20) measurement expression for a 20-point
moving average. This will give a better indication of whether the measured signal meets
the low-level spectrum mask specification at frequencies far from the carrier.

 

 Special Attention for EVM Measurements

For the EVM measurement, the user can specify a start time. The EVM for the initial
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wireless segment may be unusually high (due to signal startup transient effects or other
reasons) that cause a mis-detected first frame that the user does not want included in the
RF DUT EVM measurement.
To remove the degraded initial burst EVM values from the RF DUT EVM measurement, set
the EVM_Start to a value greater than or equal to the RF DUT time delay characteristic.
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 UWB Receiver Performance Test with
WLAN 11a Interference
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 Introduction
UWB_RX_with_WLAN_11a_Interferer_test is the test bench for UWB receiver performance
with WLAN 11a interferer. The test bench enables users to connect to an RF DUT and
determine its performance; signal measurements include signal spectrum, BER and PER.

The signal and the measurement are designed according to Reference 1 (adswtbuwb).

This test bench includes a TX DSP section, an RF modulator, RF output source resistance,
an RF DUT connection, RF receivers, and DSP measurement blocks as illustrated in the
following figure. The generated test signal is sent to the DUT.

 

 Receiver Wireless Test Bench Block Diagram

The UWB PLCP frame format is shown in the following figure. Each frame is separated by
IdleInterval and consists of three parts: the PLCP preamble, PLCP header (PHY header,
MAC header, header check sequence, tail bits, and pad bits), MAC frame body (frame
payload plus FCS, tail bits, and pad bits).

 

 PLCP Frame Format

The standard PLCP preamble consists of two portions: the time domain packet and frame
synchronization sequence; and the frequency domain channel estimation sequence. The
basic sequence for time domain packet and frame synchronization sequence is
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implemented by model UWB_TimeDomainSeq. The frequency domain channel estimation
sequence is implemented by a model WaveFormCx. The basic sequence of timed domain
packet and frame synchronization is repeated and combined with FFT'd frequency domain
channel estimation sequence and FFT'd frame body in model UWB_MuxFrame.

According to the specification, the frame body shall be encoded in the following manner.
The PLCP header (consisting of the PHY header and associated tail bits, the MAC header
plus HCS, and the associated tail bits, followed by the pad bits as in Section 1.3.8[1])
shall be encoded with a rate R = 1/3. The encoder shall be reset to the all-zero state
following this. Next, the MAC frame body, tail bits and pad bits appended shall be encoded
with a rate R = 1/3, 11/32, 1/2, 5/8, or 3/4, corresponding to the desired data rate. The
algorithm to reset the encoder after encoding PLCP header is as follows:

Append 6 extra tail bits after PLCP header
Convolutionally encode the PLCP header and extra tail bits. with a rate R = 1/3. The
encoder is reset to the all-zero state following this.
Remove 18 symbols generated from the 6 tail bits.

Although there is no requirement for the encoder to be reset after encoding the MAC
frame body, tail bits and pad bits appended, it is a requirement of the simulation. So the
same algorithm is implemented.

The number of OFDM symbols per UWB-OFDM frame also consists of three parts.

There are 30 or 18 OFDM symbols for Standard preamble or Shortened preamble,
respectively.

The preceding illutration of the frame format shows the PLCP Header, whose data rate is
53.3 Mb/s. It includes PHY Header (40 bits), first Tail Bits (6 bits), MAC Header (80 bits),
HCS (header check sequence, 16 bits) second Tail Bits (6 bits), and pad bits. The total bits
of PLCP Header is 148 bits. The OFDM symbols of PLCP Header before time-domain
spreading is computed as follows:

Where TSF=2, NCBPS=100 and R=1/3 from the table of Rate-dependent parameters
(adswtbuwb) because PLCP Header is always 53.3 Mb/s. The number pad bits is 52
(!adswtbuwb-4-1-05.gif! ).

So the OFDM symbols of PLCP Header after time-domain spreading is as follows:
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MAC frame body consists of frame payload, FCS, tail bits, and pad bits. The OFDM
symbols of PSDU before time-domain spreading is computed as follows:

Where R is the data rate of PSDU, TSF and NCBPS are determined by the data rate and
DataLength is the number of data bytes in the frame payload part of each PLCP frame.
Please refer to the table of Rate-dependent parameters (adswtbuwb) for detail.

The number of pad bits is:

The OFDM symbols of PSDU before time-domain spreading is computed as follows:

So, the total number of OFDM symbols  per UWB-OFDM frame is

The UWB RF power delivered into a matched load is the average power delivered in the
UWB frame excluding the idle time. The following figure shows the RF envelope for an
output RF signal with -9.9 dBm power.
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 UWB RF Signal Envelope
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 Test Bench Basics
A template is provided for this test bench.

 

 UWB Receiver Test Bench

To access the template:

In an Analog/RF schematic window select Insert > Template.1.
In the Insert > Template dialog box, choose2.
UWB_RX_with_WLAN_11a_Interferer_test , click OK ; click left to place the template
in the schematic window.
An example design using this template is available; from the ADS Main window click
File > Open > Example > UWB> UWB_RF_Verification_wrk >
UWB_RX_with_WLAN_11a_Interferer_test .
The basics for using the test bench are:

Replace the DUT (Amplifier2 is provided with this template) with an RF DUT that is
suitable for this test bench.
CE_TimeStep, SourcePower, and FMeasurement parameter default values are
typically accepted; otherwise, set values based on your requirements.
Activate/deactivate measurements based on your requirements.
Run the simulation and view Data Display page(s) for your measurement(s).
For details, refer to Test Bench Details.
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 Test Bench Details
The following sections provide details for setting up a test bench, setting measurement
parameters for more control of the test bench, simulation measurement displays, and
baseline performance.

Open and use the UWB_RX_with_WLAN_11a_Interferer_test template:

In an Analog/RF schematic window select Insert > Template.1.
In the Insert > Template dialog box, choose2.
UWB_RX_with_WLAN_11a_Interferer_test , click OK ; click left to place the template
in the schematic window.

Test bench setup is detailed here.

Replace the DUT (Amplifier2 is provided with this template) with an RF DUT that is1.
suitable for this test bench.
For information regarding using certain types of DUTs, see RF DUT Limitations for
UWB Wireless Test Benches (adswtbuwb).
 
 
Set the Required Parameters2.

Note Refer to UWB_RX_with_WLAN_11a_Interferer (adswtbuwb) for a complete list of parameters
for this test bench.

Generally, default values can be accepted; otherwise, values can be changed by the
user as needed.  

Set CE_TimeStep.
Cosimulation occurs between the test bench (using ADS Ptolemy Data Flow
simulation technology) and the DUT (using Circuit Envelope simulation
technology). Each technology requires its own simulation time step with time-
step coordination occurring in the interface between the technologies.
CE_TimeStep defines the Circuit Envelope simulation time step to be used with
this DUT. The CE_TimeStep must be set to a value equal to or a submultiple of
(less than) WTB_TimeStep; otherwise, simulation will stop and an error
message will be displayed.
Note that WTB_TimeStep is not user-settable. Its value is derived from other
test bench parameter values; with default settings WTB_TimeStep=0.9470 nsec.
The value is displayed in the Data Display pages as TimeStep.
WTB_TimeStep = 1/528 MHz/(2OversamplingOption)
where:
528 MHz is the bandwidth of UWB OFDM signal
2OversamplingOption is the oversampling ratio value. Oversampling ratio sets the
number of waveform sampling points during the signal FFT time interval. During
this time interval the minimum FFT sampling size is 128 (which corresponds to
an FFT order of 7; i.e 27 ) and the FFT time interval is defined as 128/528 MHz.
For example, a Ratio of 4 sets the FFT sampling size to 128 × 4=512 (which
corresponds to an FFT order of 9) during the signal FFT time interval.
Set SourcePower, and FMeasurement.

SourcePower defines the power level of the source. SourcePower is defined
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as the average power during the non-idle time of the signal burst.
FMeasurement defines the RF frequency output from the DUT to be
measured.

More control of the test bench can be achieved by setting Basic Parameters , Signal3.
Parameters , and measurement parameters . For details, refer to Setting Parameters
(adswtbuwb).
The RF modulator (shown in the Receiver Wireless Test Bench Block Diagram) uses4.
SourcePower ( Required Parameters ), GainImbalance, PhaseImbalance( Signal
Parameters ).
The RF output resistance uses SourceR and SourceTemp ( Basic Parameters ). The RF
output signal source has a 50-ohm (default) output resistance defined by SourceR.
RF output (and input to the RF DUT) is delivered into a matched load of resistance
SourceR, with frequency hopping, with the specified source resistance (SourceR) and
with power (SourcePower) . The RF signal has additive Gaussian noise power set by
resistor temperature (SourceTemp).
Note that the Meas_in point of the test bench provides a resistive load to the RF DUT
set by the MeasR value (50-ohm default) ( Basic Parameters ).
The Meas signal contains linear and nonlinear signal distortions and time delays
associated with the RF DUT input to output characteristics.
The TX DSP block (shown in the Receiver Wireless Test Bench Block Diagram) uses
other Signal Parameters .
 More control of Circuit Envelope analysis can be achieved by setting Envelope5.
controller parameters. These settings include Enable AVM (Fast Cosim), which may
speed the RF DUT simulation more than 10×. Setting these simulation options is
described in Setting Automatic Verification Modeling Parameters and Setting Circuit
Envelope Analysis Parameters in the Wireless Test Bench Simulation documentation.
After running a simulation, results will appear in a Data Display window for the6.
measurement. Simulation Measurement Displays (adswtbuwb) describes results for
each measurement. For general WTB Data Display details refer to Viewing WTB
Analysis Results (adswtbsim).
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 UWB_RX_with_WLAN_11a_Interferer
  

This section provides parameter information for Required Parameters, Basic Parameters,
Signal Parameters, and parameters for the various measurements.

 Parameters

Name Description Default Sym Unit Type Range

RequiredParameters       

CE_TimeStep Circuit envelope simulation time step 1/528
MHz/2

 sec real (0, ∞)

WTB_TimeStep Set CE_TimeStep< =1/528
MHz/2^OversamplingOption. Expression
variables are in Signal Parameters
tab/category.

     

SourcePower Source power dbmtow(-
9.9)

 W real [0, ∞)

FMeasurement Measurement carrier frequency 4224 MHz  Hz real
enum

(0, ∞)

BasicParameters       

SourceR Source resistance 50 Ohm  Ohm real (0, ∞)

SourceTemp Source resistor temperature 16.85  Celsius real [-
273.15,
∞)

MeasR Measurement resistance 50 Ohm  Ohm real [10,
1.0e6]

TestBenchSeed Random number generator seed 1234567   int [0, ∞)

SignalParameters       

GainImbalance Gain imbalance, Q vs I 0.0  dB real (-∞, ∞)

PhaseImbalance Phase imbalance, Q vs I 0.0  deg real (-∞, ∞)

DataPattern Data pattern: PN9, PN15, FIX4,
_4_1_4_0, _8_1_8_0, _16_1_16_0,
_32_1_32_0, _64_1_64_0

PN9   enum

BandGroup Band group:
BandGroup1
BandGroup2
BandGroup3
BandGroup4
BandGroup5

BandGroup1   enum  
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BandGroup6

DataRate Data rate: _53.3Mbps, _55Mbps,
_80Mbps, _106.67Mbps, _110Mbps,
_160Mbps, _200Mbps, _320Mbps,
_400Mbps,_480Mbps

_53.3Mbps   enum [1,4095]

DataLength Octet number of PSDU 1024   int  

PreambleFormat PLCP preamble format: Standard
Format, Shortened Format

Standard
Format

  enum  

TFC_Number Time-frequency code number: TFC1,
TFC2, TFC3, TFC4, TFC5, TFC6

TFC1   enum  

OversamplingOption Oversampling ratio option: Ratio 1, Ratio
2, Ratio 4, Ratio 8, Ratio 16, Ratio 32,
Ratio 64

Ratio 2   enum  

ScramblerSeed Scrambler seed selection: Seed 00, Seed
01, Seed 10, Seed 11

Seed 00   enum  

MeasurementParameters       

DisplayPages RX sensitivity display pages:
UWB_RX_with_WLAN_11a_Interferer
Tables

     

Delay Frequency synthesizer delay 1.8939 nsec   real  

StartBurst Start block 1   int [0,
1000]

StopBurst Stop block 50   int [1,
1000]

DataSet dataSet file to construct Expression from     [0,
1000]

Expression variable/sink name from dataset     [1,
1000]

WLAN11aPower WLAN 11a interferer power 1-17  W real (0, ∞)

FWLAN11a WLAN 11a carrier frequency 5.1GHz  Hz real (0, ∞)

WLAN11aSampleRate WLAN 11a source sampling rate 20e6*2 5  Hz real (0, ∞)

 Pin Input

Pin Name Description

2 Meas_In Test bench measurement RF input from RF circuit

 Pin Output

Pin Name Description

1 RF_Out Test bench RF output to RF circuit
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 Setting Parameters
More control of the test bench can be achieved by setting parameters in the Basic
Parameters , Signal Parameters , and measurement categories for the activated
measurements.

Note For required parameter information, see the Set the Required Parameters (adswtbuwb) step in the
test bench setup procedure.

  

 Basic Parameters

SourceR is the RF output source resistance.1.
SourceTemp is the RF output source resistance temperature (oC) and sets noise2.
density in the RF output signal to (k(SourceTemp+273.15)) Watts/Hz, where k is
Boltzmann's constant.
MeasR defines the load resistance for the RF DUT output Meas signal into the test3.
bench. This resistance loads the RF DUT output; it is also the reference resistance for
Meas signal power measurements.
TestBenchSeed is an integer used to seed the random number generator used with4.
the test bench. This value is used by all test bench random number generators,
except those RF DUT components that use their own specific seed parameter.
TestBenchSeed initializes the random number generation. The same seed value
produces the same random results, thereby giving you predictable simulation results.
To generate repeatable random output from simulation to simulation, use any
positive seed value. If you want the output to be truly random, enter the seed value
of 0.

  

 Signal Parameters

GainImbalance, PhaseImbalance are used to add certain impairments to the ideal1.
output RF signal. Impairments are added in the order described here.
The unimpaired RF I and Q envelope voltages have gain and phase imbalance
applied. The RF is given by:

where A is a scaling factor that depends on the SourcePower and SourceR
parameters specified by the user, VI( t ) is the in-phase RF envelope, VQ( t ) is the

quadrature phase RF envelope, g is the gain imbalance

and, φ (in degrees) is the phase imbalance.
For DataPattern:2.

if PN9 is selected, a 511-bit pseudo-random test pattern is generated according
to CCITT Recommendation O.153.
if PN15 is selected, a 32767-bit pseudo-random test pattern is generated
according to CCITT Recommendation O.151.
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if FIX4 is selected, a zero-stream is generated.
if x_1_x_0 is selected (where x equals 4, 8, 16, 32, or 64) a periodic bit stream
is generated, with the period being 2 x. In one period, the first x bits are 1s and
the second x bits are 0s.

DataRate, DataLength, ScramblerSeed are used to set the multi-band OFDM PHY3.
specific service parameter. These parameters will be transmitted in the PHY header
and also be used to frame the packets. When the DataRate is set, the data rate-
dependent parameters such as modulation, coding rate, conjugate symmetric Input
to IFFT, time spreading factor, overall spreading gain and coded bits per OFDM
symbol (NCBPS) will be set according to the specification. Please refer to the following

table of rate-dependent parameters for detail. Although there are 10 choices for
parameter DataRate, only 8 of them are supported. The data rate 55 Mbps and 106.7
Mbps are kept for future extension.

 Rate-dependent parameters

Data Rate
(Mb/s)

Modulation Coding
rate
(R)

Conjugate
Symmetric
Input to
IFFT

Time
Spreading
Factor
(TSF)

Overall
Spreading
Gain

Coded bits
per
OFDM
symbol
(NCBPS)

53.3 QPSK 1/3 Yes 2 4 100

80 QPSK 1/2 Yes 2 4 100

110 QPSK 11/32 No 2 2 200

160 QPSK 1/2 No 2 2 200

200 QPSK 5/8 No 2 2 200

320 DCM 1/2 No 1 (No spreading) 1 200

400 DCM 5/8 No 1 (No spreading) 1 200

480 DCM 3/4 No 1 (No spreading) 1 200

DataLength is used to set the number of data bytes in the frame payload part of each4.
PLCP frame. There are 8 bits per byte.
PreambleFormat indicates which type of preamble is used.5.
TFC_Number indicates which time frequency code is used.6.
OversamplingOption sets the oversampling ratio of UWB RF signal source, where7.
oversampling ratio = 2 OversamplingOption . If OversamplingOption = 2, and the
simulation RF bandwidth is larger than the signal bandwidth by a factor of 2
OversamplingOption .

  

 Measurement Parameters

DisplayPages provides Data Display page information for this measurement. It cannot1.
be changed by the user.
Delay indicates the delay introduced for UWB_Freq_Hopping in UWB_Receiver_FH_RF2.
in order to compensate the delay introduced by DUT to make the local carrier
synchronized with the carrier in received signal approximately.
StartBlock sets the start frame.3.
StopBurst sets the stop frame.4.
WLAN11aPowr sets the WLAN 11a interferer power5.
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DataSet and Expression set the interferer data file and interferer variable6.
FWLAN11a set the WLAN 11a interferer carrier frequency7.
WLAN11aSampleRate set the WLAN 11a interferer sample rate8.
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 Simulation Measurement Displays
After running the simulation, results are displayed in the Data Display pages for each
measurement activated.

Note Measurement results from a wireless test bench have associated names that can be used in Data
Display Expressions. For more information, refer to Measurement Results for Expressions (adswtbuwb).

 

 Interference Measurement

 The interference measurement shows BER and PER results.

In this testbench, the UWB signal works on BandGroup 1 occupying the spectrum from
3168 MHz to 4752 MHz, while the WLAN 11a is at 5.19 GHz with a bandwidth of 20 MHz
as an out-of-band interferer.

To display and analyze the combined signals, the parameter OversamplingOption of UWB
source should be set to 3 or larger. The WLAN 11a interference signal is loaded from
dataset file, with 20MHz bandwidth and the 20*32 MHz sample rate. The data rate is 54
Mbps and the data length is 1024 bytes. The 11a signal will be interpolated and decimated
to the same sampling rate as the UWB signal in the testbench.

 

 Test Bench Variables for Data Displays

 
The following tables identify the reference variables used to set up this test bench:

 Test Bench Constants for UWB Signal Setup

Constant Value

DR DataRate+1

N_CBPS {100, 100, 100, 200, 200, 200, 200, 200, 200, 200}

CodingRate {1/3, 11/32, 1/2, 1/3, 11/32, 1/2, 5/8, 1/2, 5/8, 3/4}

TSF {2, 2, 2, 2, 2, 2, 2, 1, 1, 1}

UsefulBits DataLength*8+32+6

N_Sym_Data 6/TSF[DR]*ceil(ceil(UsefulBits/CodingRate[DR])/(6/TSF[DR]*N_CBPS[DR]))

N_Sym_Preamble if(PreambleFormat==0) then 30 else 18 endif

N_Sym_Header 12

SymbolsPerFrame N_Sym_Data*TSF[DR]+N_Sym_Header+N_Sym_Preamble

SamplesPerSymbol 2^(7+OversamplingOption)+int((70.08e-9)/TimeStep+0.5)

SamplesPerFrame SamplesPerSymbol*SymbolsPerFrame

FrameTime 312.5e-9*SymbolsPerFrame

TimeStep 1/528MHz/2^OversamplingOption

ScramblerSeed_Receiver if(ScramblerSeed==0) then 3 elseif(ScramblerSeed==1) then 0
elseif(ScramblerSeed==2) then 1 else 2 endif
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 DataRate Determines BitRate Values

DataRate BitRate (See following table)

_53.3Mbps 53.3e6

_55Mbps 55e6

_80Mbps 80e6

_106.67Mbps 106.67e6

_110Mbps 110e6

_160Mbps 160e6

_200Mbps 200e6

_320Mbps 320e6

_400Mbps 400e6

_480Mbps 480e6

 Test Bench Equations Derived from Test Bench Parameters or variables and Exported to Data Display

Data Display Parameter Equation with Test Bench Parameters

RF_SourcePower_dBm 10*log10(SourcePower)+30

RF_SourceR SourceR

RF_SourceTemp SourceTemp in degrees Celcius

Meas_FMeasurement FMeasurement

Meas_R MeasR

DataLen DataLength
Octet number of PSDU

OversamplingRatio 2^OversamplingOption

TStep TimeStep

BitRate Dependent on DataRate in previous table
This is the bit rate for transmitted UWB signal.

SymbolData N_Sym_Data*TSF[DR]
Number of OFDM symbols within PSDU

SymbolHeader 12
Number of OFDM symbols within PLCP Header

SymbolPreamble N_Sym_Preamble
Number of OFDM symbols within Preamble

SymbolPerFrame SymbolsPerFrame
Number of OFDM symbols within each frame

FramePeriod FrameTime
Time duration of each frame

SamplePerFrame SamplesPerFrame
Number of samples within each frame

FrameMeasured StopBlock-StartBlock+1
Number of frames measured
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 Baseline Performance
Test Computer Configuration

Pentium-M 2GHz, 1.5G RAM, Windows XP
Conditions

Measurements made with default test bench settings.
RF DUT is an RF system behavior component.
SignalPower = -76.8 dBm
DataRate = 53.3 Mbps
DataLength=100 bytes
OversamplingOption = Ratio_8
WTB_TimeStep = 1/528 MHz/8
FMeasurement = 3960 MHz

 

 Expected ADS Performance

Expected ADS performance is the combined performance of the baseline test bench and
the RF DUT Circuit Envelope simulation with the same signal and number of time points.
For example, if the RF DUT performance with Circuit Envelope simulation alone takes 1
hours and consumes 200 MB of memory (excluding the memory consumed by the core
ADS product), then add these numbers to the Baseline Performance numbers to
determine the expected ADS performance. This is valid only if the full memory consumed
is from RAM. If RAM is less, larger simulation times may result due to increased disk
access time for swap memory usage.
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"Multiband OFDM Physical Layer Specification", WiMedia Alliance document, Release1.
1.1, July 14, 2005.
Setting up a Wireless Test Bench Analysis in the Wireless Test Bench Simulation
documentation explains how to use test bench windows and dialogs to perform
analysis tasks.
Setting Circuit Envelope Analysis Parameters in the Wireless Test Bench Simulation
documentation explains how to set up circuit envelope analysis parameters such as
convergence criteria, solver selection, and initial guess.
Setting Automatic Behavioral Modeling Parameters in the Wireless Test Bench
Simulation documentation to learn how to improve simulation speed.
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 UWB Receiver Sensitivity Test
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 Introduction
UWB_RX_Sensitivity_test is the test bench for UWB receiver minimum input level
sensitivity testing. The test bench enables users to connect to an RF DUT and determine
its performance; signal measurements include BER and PER with minimum input level.

The signal and the measurement are designed according to Reference 1 (adswtbuwb).

This test bench includes a TX DSP section, an RF modulator, RF output source resistance,
an RF DUT connection, RF receivers, and DSP measurement blocks as illustrated in the
following block diagram. The generated test signal is sent to the DUT.

 

 Receiver Wireless Test Bench Block Diagram

The UWB PLCP frame format is shown in PLCP Frame Format. Each frame is separated by
IdleInterval and consists of three parts: the PLCP preamble, PLCP header (PHY header,
MAC header, header check sequence, tail bits, and pad bits), MAC frame body (frame
payload plus FCS, tail bits, and pad bits).

 

 PLCP Frame Format

The standard PLCP preamble consists of two portions: the time domain packet and frame
synchronization sequence; and the frequency domain channel estimation sequence. The
basic sequence for time domain packet and frame synchronization sequence is
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implemented by model UWB_TimeDomainSeq. The frequency domain channel estimation
sequence is implemented by a model WaveFormCx. The basic sequence of timed domain
packet and frame synchronization is repeated and combined with FFT'd frequency domain
channel estimation sequence and FFT'd frame body in model UWB_MuxFrame.

According to the specification, the frame body shall be encoded in the following manner.
The PLCP header (consisting of the PHY header and associated tail bits, the MAC header
plus HCS, and the associated tail bits, followed by the pad bits as in Section 1.3.8[1])
shall be encoded with a rate R = 1/3. The encoder shall be reset to the all-zero state
following this. Next, the MAC frame body, tail bits and pad bits appended shall be encoded
with a rate R = 1/3, 11/32, 1/2, 5/8, or 3/4, corresponding to the desired data rate. The
algorithm to reset the encoder after encoding PLCP header is as follows:

Append 6 extra tail bits after PLCP header
Convolutionally encode the PLCP header and extra tail bits. with a rate R = 1/3. The
encoder is reset to the all-zero state following this.
Remove 18 symbols generated from the 6 tail bits.

Although there is no requirement for the encoder to be reset after encoding the MAC
frame body, tail bits and pad bits appended, it is a requirement of the simulation. So the
same algorithm is implemented.

The number of OFDM symbols per UWB-OFDM frame also consists of three parts.

There is 30 or 18 OFDM symbols for Standard preamble or Shortened preamble,
respectively.

The preceding figure shows the PLCP Header, whose data rate is 53.3 Mb/s. It includes
PHY Header (40 bits), first Tail Bits (6 bits), MAC Header (80 bits), HCS (header check
sequence, 16 bits) second Tail Bits (6 bits), and pad bits. The total bits of PLCP Header is
148 bits. The OFDM symbols of PLCP Header before time-domain spreading is computed
as follows:

Where TSF=2, NCBPS=100 and R=1/3 from the table of Rate-dependent parameters
(adswtbuwb) because PLCP Header is always 53.3 Mb/s. The number pad bits is 52 (

).
So the OFDM symbols of PLCP Header after time-domain spreading is as follows:
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MAC frame body consists of frame payload, FCS, tail bits, and pad bits. The OFDM
symbols of PSDU before time-domain spreading is computed as follows:

Where R is the data rate of PSDU, TSF and NCBPS are determined by the data rate and
DataLength is the number of data bytes in the frame payload part of each PLCP frame.
Please refer to the table of Rate-dependent parameters (adswtbuwb) for detail.

The number of pad bits is:

The OFDM symbols of PSDU before time-domain spreading is computed as follows:

So, the total number of OFDM symbols 
per UWB-OFDM frame is

The UWB RF power delivered into a matched load is the average power delivered in the
UWB frame excluding the idle time. The following figure shows the RF envelope for an
output RF signal with -9.9 dBm power.



Advanced Design System 2011.01 - UWB Wireless Test Benches

35

 

 UWB RF Signal Envelope
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 Test Bench Basics
A template is provided for this test bench.

 

 UWB Receiver Test Bench

To access the template:

In an Analog/RF schematic window select Insert > Template.1.
In the Insert > Template dialog box, choose UWB_RX_Sensitivity_test , click OK ;2.
click left to place the template in the schematic window.

An example design using this template is available; from the ADS Main window click File >
Open > Example > UWB> UWB_RF_Verification_wrk > UWB_RX_Sensitivity_test .

The basics for using the test bench are:

Replace the DUT (Amplifier2 is provided with this template) with an RF DUT that is
suitable for this test bench.
CE_TimeStep, SourcePower, and FMeasurement parameter default values are
typically accepted; otherwise, set values based on your requirements.
Activate/deactivate measurements based on your requirements.
Run the simulation and view Data Display page(s) for your measurement(s).

For details, refer to Test Bench Details.
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 Test Bench Details
The following sections provide details for setting up a test bench, setting measurement
parameters for more control of the test bench, simulation measurement displays, and
baseline performance.

Open and use the UWB_RX_Sensitivity_test template:

In an Analog/RF schematic window select Insert > Template.1.
In the Insert > Template dialog box, choose UWB_RX_Sensitivity_test , click OK ;2.
click left to place the template in the schematic window.

Test bench setup is detailed here.

Replace the DUT (Amplifier2 is provided with this template) with an RF DUT that is1.
suitable for this test bench.

For information regarding using certain types of DUTs, see RF DUT
Limitations for UWB Wireless Test Benches (adswtbuwb).

Set the  Required Parameters2.

Note
Refer to UWB_RX_Sensitivity (adswtbuwb) for a complete list of parameters for this test bench.

Generally, default values can be accepted; otherwise, values can be changed by the
user as needed.

 Set CE_TimeStep.

Cosimulation occurs between the test bench (using ADS Ptolemy Data Flow
simulation technology) and the DUT (using Circuit Envelope simulation
technology). Each technology requires its own simulation time step with time-
step coordination occurring in the interface between the technologies.

CE_TimeStep defines the Circuit Envelope simulation time step to be used with
this DUT. The CE_TimeStep must be set to a value equal to or a submultiple of
(less than) WTB_TimeStep; otherwise, simulation will stop and an error
message will be displayed.

Note that WTB_TimeStep is not user-settable. Its value is derived from other
test bench parameter values; with default settings WTB_TimeStep=0.9470 nsec.
The value is displayed in the Data Display pages as TimeStep.

WTB_TimeStep = 1/528 MHz/(2OversamplingOption)

where

528 MHz is the bandwidth of UWB OFDM signal

2^OversamplingOption is the oversampling ratio value. Oversampling ratio sets
the number of waveform sampling points during the signal FFT time interval.
During this time interval the minimum FFT sampling size is 128 (which
corresponds to an FFT order of 7; i.e 2 7 ) and the FFT time interval is defined as
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128/528 MHz. For example, a Ratio of 4 sets the FFT sampling size to
128 × 4=512 (which corresponds to an FFT order of 9) during the signal FFT
time interval.
Set SourcePower, and FMeasurement.

SourcePower defines the power level of the source. SourcePower is defined
as the average power during the non-idle time of the signal burst.
FMeasurement defines the RF frequency output from the DUT to be
measured.

More control of the test bench can be achieved by setting Basic Parameters , Signal3.
Parameters , and measurement parameters. For details, refer to Setting Parameters
(adswtbuwb).
The RF modulator (shown in the block diagram in Receiver Wireless Test Bench Block4.
Diagram) uses SourcePower ( Required Parameters ), GainImbalance,
PhaseImbalance( Signal Parameters ).

The RF output resistance uses SourceR and SourceTemp ( Basic Parameters ). The RF
output signal source has a 50-ohm (default) output resistance defined by SourceR.
RF output (and input to the RF DUT) is delivered into a matched load of resistance
SourceR, with frequency hopping, with the specified source resistance (SourceR) and
with power (SourcePower) . The RF signal has additive Gaussian noise power set by
resistor temperature (SourceTemp).

Note that the Meas_in point of the test bench provides a resistive load to the RF DUT
set by the MeasR value (50-ohm default) ( Basic Parameters).

The Meas signal contains linear and nonlinear signal distortions and time delays
associated with the RF DUT input to output characteristics.

The TX DSP block (shown in the block diagram in Receiver Wireless Test Bench Block
Diagram) uses other Signal Parameters .
 More control of Circuit Envelope analysis can be achieved by setting Envelope5.
controller parameters. These settings include Enable Fast Cosim, which may speed
the RF DUT simulation more than 10×. Setting these simulation options is described
in Setting Fast Cosimulation Parameters and Setting Circuit Envelope Analysis
Parameters in the Wireless Test Bench Simulation documentation.
After running a simulation, results will appear in a Data Display window for the6.
measurement. Simulation Measurement Displays (adswtbuwb) describes results for
each measurement. For general WTB Data Display details refer to Viewing WTB
Analysis Results (adswtbsim).
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 UWB_RX_Sensitivity
 

This section provides parameter information for Required Parameters, Basic Parameters,
Signal Parameters, and parameters for the various measurements.

 Parameters
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Name Description Default Sym Unit Type Range

RequiredParameters       

CE_TimeStep Circuit envelope simulation time step 1/528
MHz/2

 sec real (0, ∞)

WTB_TimeStep Set CE_TimeStep< =1/528
MHz/2^OversamplingOption.
Expression variables are in Signal
Parameters tab/category.

    

SourcePower Source power dbmtow(-
9.9)

 W real [0, ∞)

FMeasurement Measurement carrier frequency 4224 MHz  Hz real
enum

(0, ∞)

BasicParameters       

SourceR Source resistance 50 Ohm  Ohm real (0, ∞)

SourceTemp Source resistor temperature 16.85  Celsius real [-
273.15,
∞)

MeasR Measurement resistance 50 Ohm  Ohm real [10,
1.0e6]

TestBenchSeed Random number generator seed 1234567   int [0, ∞)

SignalParameters       

GainImbalance Gain imbalance, Q vs I 0.0  dB real (-∞, ∞)

PhaseImbalance Phase imbalance, Q vs I 0.0  deg real (-∞, ∞)

DataPattern Data pattern: PN9, PN15, FIX4,
_4_1_4_0, _8_1_8_0, _16_1_16_0,
_32_1_32_0, _64_1_64_0

PN9   enum

BandGroup Band group: BandGroup1   enum

DataRate Data rate: _53.3Mbps, _55Mbps,
_80Mbps, _106.67Mbps, _110Mbps,
_160Mbps, _200Mbps, _320Mbps,
_400Mbps,_480Mbps

_53.3Mbps   enum [1,4095]

DataLength Octet number of PSDU 1024   int  

PreambleFormat PLCP preamble format: Standard
Format, Shortened Format

Standard
Format

  enum

TFC_Number Time-frequency code number: TFC1,
TFC2, TFC3, TFC4, TFC5, TFC6

TFC1   enum  

OversamplingOption Oversampling ratio option: Ratio 1,
Ratio 2, Ratio 4, Ratio 8, Ratio 16,
Ratio 32, Ratio 64

Ratio 2   enum  

ScramblerSeed Scrambler seed selection: Seed 00,
Seed 01, Seed 10, Seed 11

Seed 00   enum  

MeasurementParameters       

DisplayPages RX sensitivity display pages:      

Delay Frequency synthesizer delay 1.8939 nsec   real  

StartBurst Start block 1   int [0,
1000]

StopBurst Stop block 50   int [1,
1000]

 Pin Inputs
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Pin Name Description

2 Meas_In Test bench measurement RF input from RF circuit

 Pin Outputs

Pin Name Description

1 RF_Out Test bench RF output to RF circuit
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 Setting Parameters
More control of the test bench can be achieved by setting parameters in the Basic
Parameters , Signal Parameters , and measurement categories for the activated
measurements.

Note For required parameter information, see the Set the required parameters (adswtbuwb) step under
Test Bench Details.

  

 Basic Parameters

SourceR is the RF output source resistance.1.
SourceTemp is the RF output source resistance temperature (oC) and sets noise2.
density in the RF output signal to (k(SourceTemp+273.15)) Watts/Hz, where k is
Boltzmann's constant.
MeasR defines the load resistance for the RF DUT output Meas signal into the test3.
bench. This resistance loads the RF DUT output; it is also the reference resistance for
Meas signal power measurements.
TestBenchSeed is an integer used to seed the random number generator used with4.
the test bench. This value is used by all test bench random number generators,
except those RF DUT components that use their own specific seed parameter.
TestBenchSeed initializes the random number generation. The same seed value
produces the same random results, thereby giving you predictable simulation results.
To generate repeatable random output from simulation to simulation, use any
positive seed value. If you want the output to be truly random, enter the seed value
of 0.

  

 Signal Parameters

GainImbalance, PhaseImbalance are used to add certain impairments to the ideal1.
output RF signal. Impairments are added in the order described here.
The unimpaired RF I and Q envelope voltages have gain and phase imbalance
applied. The RF is given by:

where A is a scaling factor that depends on the SourcePower and SourceR
parameters specified by the user, VI( t ) is the in-phase RF envelope, VQ( t ) is the

quadrature phase RF envelope, g is the gain imbalance

and, φ (in degrees) is the phase imbalance.
For DataPattern:2.

if PN9 is selected, a 511-bit pseudo-random test pattern is generated according
to CCITT Recommendation O.153.
if PN15 is selected, a 32767-bit pseudo-random test pattern is generated
according to CCITT Recommendation O.151.
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if FIX4 is selected, a zero-stream is generated.
if x_1_x_0 is selected (where x equals 4, 8, 16, 32, or 64) a periodic bit stream
is generated, with the period being 2 x. In one period, the first x bits are 1s and
the second x bits are 0s.

DataRate, DataLength, ScramblerSeed are used to set the multi-band OFDM PHY3.
specific service parameter. These parameters will be transmitted in the PHY header
and also be used to frame the packets. When the DataRate is set, the data rate-
dependent parameters such as modulation, coding rate, conjugate symmetric Input
to IFFT, time spreading factor, overall spreading gain and coded bits per OFDM
symbol (NCBPS) will be set according to the specification. Please refer to the table of

rate-dependent parameters below for detail. Although there are 10 choices for
parameter DataRate, only 8 of them are supported. The data rate 55 Mbps and 106.7
Mbps are kept for future extension.

 Rate-dependent parameters

Data Rate
(Mb/s)

Modulation Coding rate Conjugate Time Overall Coded bits per
OFDM symbol
(NCBPS)

53.3 QPSK 1/3 Yes 2 4 100

80 QPSK 1/2 Yes 2 4 100

110 QPSK 11/32 No 2 2 200

160 QPSK 1/2 No 2 2 200

200 QPSK 5/8 No 2 2 200

320 DCM 1/2 No 1 (No spreading) 1 200

400 DCM 5/8 No 1 (No spreading) 1 200

480 DCM 3/4 No 1 (No spreading) 1 200

DataLength is used to set the number of data bytes in the frame payload part of each4.
PLCP frame. There are 8 bits per byte.
PreambleFormat indicates which type of preamble is used.5.
TFC_Number indicates which time frequency code is used.6.
OversamplingOption sets the oversampling ratio of UWB RF signal source, where7.
oversampling ratio = 2 OversamplingOption . If OversamplingOption = 2, and the
simulation RF bandwidth is larger than the signal bandwidth by a factor of 2
OversamplingOption .

  

 Measurement Parameters

DisplayPages provides Data Display page information for this measurement. It cannot1.
be changed by the user.
Delay indicates the delay introduced for UWB_Freq_Hopping in UWB_Receiver_FH_RF2.
in order to compensate the delay introduced by DUT to make the local carrier
synchronized with the carrier in received signal approximately.
StartBlock sets the start frame.3.
StopBurst sets the stop frame.4.
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 Simulation Measurement Displays
After running the simulation, results are displayed in the Data Display pages for each
measurement activated.

Note
Measurement results from a wireless test bench have associated names that can be used in Data Display
Expressions. For more information, refer to Measurement Results for Expressions for UWB Wireless Test
Benches (adswtbuwb).

 

 Sensitivity Measurement

 The sensitivity measurement shows BER and PER results.

The table of minimum sensitivity performance requirements defines receiver minimum
sensitivity measured at the receiver antenna connector for each data rate in UWB
specification. SourcePower can be set at the value in the table to perform receive
minimum sensitivity tests. According to specification [1] 1.6.1, the packet error rate (PER)
shall be less than 10% with a PSDU of 1024 bytes at rate-dependent input levels listed in
Table 3-2 or less. If the SourcePower is less than the value in the table when PER is less
than 10%, the sensitivity measurement is passed.

Data Rate (Mbps) Minimum sensitivity (dBm)

53.3 -80.8

80 -78.9

106.7 -77.8

160 -75.9

200 -74.5

320 -72.8

400 -71.5

480 -70.4

Simulation results for data rate of 200 Mbps and SourcePower of -76.8 dBm are displayed
in the following figure.

 

 Simulation Results for 200 Mbps Data Rate and -76.8 dBm SourcePower
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Parameters in the Data Display are described in Test Bench Equations Derived from Test
Bench Parameters or variables and Exported to Data Display. EbN0_RF_dB is the local
Eb/N0 measured at the input of the RF DUT and calculated by the following equations:

T = real(RF_SourceTemp) + 273.15

k = Boltzmann's constant

N0_dBm = 10*log10(k * T) + 30

EbN0_RF_dB = real(RF_SourcePower_dBm) - N0_dBm - 10*log10(real(BitRate))

Local Eb/No and system Eb/No are described in Wireless Measurement Definitions
(adswtbsim) in Wireless Test Bench Simulation documentation.

 

 Test Bench Variables for Data Displays

 The following tables identify the reference variables used to set up this test bench:

 Test Bench Constants for UWB Signal Setup

Constant Value

DR DataRate+1

N_CBPS {100, 100, 100, 200, 200, 200, 200, 200, 200, 200}

CodingRate {1/3, 11/32, 1/2, 1/3, 11/32, 1/2, 5/8, 1/2, 5/8, 3/4}

TSF {2, 2, 2, 2, 2, 2, 2, 1, 1, 1}

UsefulBits DataLength*8+32+6

N_Sym_Data 6/TSF[DR]*ceil(ceil(UsefulBits/CodingRate[DR])/(6/TSF[DR]*N_CBPS[DR]))

N_Sym_Preamble if(PreambleFormat==0) then 30 else 18 endif

N_Sym_Header 12

SymbolsPerFrame N_Sym_Data*TSF[DR]+N_Sym_Header+N_Sym_Preamble

SamplesPerSymbol 2^(7+OversamplingOption)+int((70.08e-9)/TimeStep+0.5)

SamplesPerFrame SamplesPerSymbol*SymbolsPerFrame

FrameTime 312.5e-9*SymbolsPerFrame

TimeStep 1/528MHz/2^OversamplingOption

ScramblerSeed_Receiver if(ScramblerSeed==0) then 3 elseif(ScramblerSeed==1) then 0
elseif(ScramblerSeed==2) then 1 else 2 endif

 DataRate Determines BitRate Values
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DataRate BitRate (see the
following table)

_53.3Mbps 53.3e6

_55Mbps 55e6

_80Mbps 80e6

_106.67Mbps 106.67e6

_110Mbps 110e6

_160Mbps 160e6

_200Mbps 200e6

_320Mbps 320e6

_400Mbps 400e6

_480Mbps 480e6

 Test Bench Equations Derived from Test Bench Parameters or variables and Exported to Data Display

Data Display Parameter Equation with Test Bench Parameters

RF_SourcePower_dBm 10*log10(SourcePower)+30

RF_SourceR SourceR

RF_SourceTemp SourceTemp in degrees Celcius

Meas_FMeasurement FMeasurement

Meas_R MeasR

DataLen DataLength

OversamplingRatio 2^OversamplingOption

TStep TimeStep

BitRate Dependent on DataRate (see previous table)

SymbolData N_Sym_Data*TSF[DR]

SymbolHeader 12

SymbolPreamble N_Sym_Preamble

SymbolPerFrame SymbolsPerFrame

FramePeriod FrameTime

SamplePerFrame SamplesPerFrame

FrameMeasured StopBlock-StartBlock+1
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 Baseline Performance
Test Computer Configuration

Pentium IV 2.4 GHz, 512 MB RAM, Windows 2000
Conditions

Measurements made with default test bench settings.
RF DUT is an RF system behavior component.
SignalPower = -76.8 dBm
DataRate = 200 Mbps
DataLength=1024 bytes
OversamplingOption = Ratio_2
WTB_TimeStep = 1/528 MHz/2
FMeasurement = 3960 MHz

Simulation time and memory requirements:
UWB_RX_Sensitivity_test
Measurement

Frames
Measured

Simulation
Time (hour)

ADS Processes (MB)

RX Sensitivity 50 3 56

 

 Expected ADS Performance

Expected ADS performance is the combined performance of the baseline test bench and
the RF DUT Circuit Envelope simulation with the same signal and number of time points.
For example, if the RF DUT performance with Circuit Envelope simulation alone takes 2
hours and consumes 200 MB of memory (excluding the memory consumed by the core
ADS product), then add these numbers to the Baseline Performance numbers to
determine the expected ADS performance. This is valid only if the full memory consumed
is from RAM. If RAM is less, larger simulation times may result due to increased disk
access time for swap memory usage.
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 References
"Multiband OFDM Physical Layer Specification", WiMedia Alliance document, Release1.
1.1, July 14, 2005.
Setting up a Wireless Test Bench Analysis in the Wireless Test Bench Simulation
documentation explains how to use test bench windows and dialogs to perform
analysis tasks.
Setting Circuit Envelope Analysis Parameters in the Wireless Test Bench Simulation
documentation explains how to set up circuit envelope analysis parameters such as
convergence criteria, solver selection, and initial guess.
Setting Automatic Behavioral Modeling Parameters in the Wireless Test Bench
Simulation documentation to learn how to improve simulation speed.
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 UWB Transmitter Test
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 Introduction
The UWB_TX transmitter test bench provides a way for users to connect to an RF circuit
device under test (RF DUT) and determine its performance by activating various test
bench measurements. This test bench provides signal measurements for RF envelope,
signal power (including CCDF), constellation, spectrum, and EVM.

The signal and most of the measurements are designed according to WiMedia Multiband
OFDM Physical Layer Specification, Release 1.1.

The UWB frame structure is illustrated in the following figure. Each frame is composed of
the PLCP preamble, PLCP header and MAC frame body, tail bits and pad bits. (PLCP means
physical layer convergence procedure , PSDU means PLCP service data units )!adswtbuwb-
2-1-01.gif!

 

 UWB frame Structure
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 Test Bench Basics

 

 UWB Transmitter Test Bench

The basics for using the test bench are:

Replace the DUT (Amplifier2 is provided with this template) with an RF DUT that is
suitable for this test bench.
CE_TimeStep, SourcePower, and FMeasurement parameter default values are
typically accepted; otherwise, set values based on your requirements.
Activate/deactivate measurements based on your requirements.
Run the simulation and view Data Display page(s) for your measurement(s).
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 Test Bench Details
The following sections provide details for setting up a test bench, setting measurement
parameters for more control of the test bench, simulation measurement displays, and
baseline performance.
Open and use the UWB_TX template:

In an Analog/RF schematic window select Insert > Template.1.
In the Insert > Template dialog box, choose UWB_TX_test , click OK ; click left to2.
place the template in the schematic window.

Test bench setup is detailed here.

Replace the DUT (Amplifier2 is provided with this template) with an RF DUT that is1.
suitable for this test bench.
For information regarding using certain types of DUTs, see RF DUT Limitations for
UWB Wireless Test Benches (adswtbuwb). 
Set the  Required Parameters2.

Note
Refer to UWB_TX (adswtbuwb) for a complete list of parameters for this test bench.

Generally, default values can be accepted; otherwise, values can be changed by the
user as needed.

 Set CE_TimeStep.
Cosimulation occurs between the test bench (using ADS Ptolemy Data Flow
simulation technology) and the DUT (using Agilent Circuit Envelope simulation
technology). Each technology requires its own simulation time step with time-
step coordination occurring in the interface between the technologies.
CE_TimeStep defines the Circuit Envelope simulation time step to be used with
this DUT. The CE_TimeStep must be set to a value equal to or a submultiple of
(less than) WTB_TimeStep; otherwise, simulation will stop and an error
message will be displayed.
Note that WTB_TimeStep is not user-settable. Its value is derived from other
test bench parameter values. The value is displayed in the Data Display pages
as TimeStep.

WTB_TimeStep = 1/(Bandwidth × Ratio)

where

Bandwidth is the user-settable value (default 528 MHz)

Ratio is the oversampling ratio related to OversamplingOption as Ratio
= 2OversamplingOption. OversamplingOption sets the number of
waveform sampling points during the signal FFT time interval. During
this time interval the minimum FFT sampling size is 128 (which
corresponds to an FFT order of 7; i.e 27) and the FFT time interval is
defined as 128/Bandwidth. For example, an OversamplingOption of 2
sets the bq. FFT sampling size to 128 × 4=512 (which corresponds to
an FFT order of 9) during the signal FFT time interval.
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Set SourcePower, and FMeasurement.
SourcePower defines the power level for FSource. SourcePower is defined
as the average power during the non-idle time of the signal frame.
FMeasurement defines the RF frequency output from the DUT to be
measured.

Activate/deactivate ( YES / NO ) test bench measurements (refer to UWB_TX3.
(adswtbuwb)). At least one measurement must be enabled:

RF_EnvelopeMeasurement
Constellation
PowerMeasurement
SpectrumMeasurement
EVM_Measurement

More control of the test bench can be achieved by setting Basic Parameters , Signal4.
Parameters , and parameters for each activated measurement. For details, refer to
Setting Parameters (adswtbuwb).
The RF modulator of UWB_TX(shown in the preceding block diagram) uses5.
SourcePower ( Required Parameters ), GainImbalance, PhaseImbalance( Signal
Parameters ).

The RF output resistance uses SourceR, SourceTemp, and
EnableSourceNoise ( Basic Parameters ). The RF output signal source has a
50-ohm (default) output resistance defined by SourceR.

RF output (and input to the RF DUT) is with the specified source resistance
(SourceR) and with power (SourcePower) delivered into a matched load of
resistance SourceR. The RF signal has additive Gaussian noise power set by
resistor temperature (SourceTemp) (when EnableSourceNoise=YES).

Note that the Meas point of the test bench provides a resistive load to the
RF DUT set by the MeasR value (50-ohm default) ( Basic Parameters ).

The Meas signal contains linear and nonlinear signal distortions and time
delays associated with the RF DUT input to output characteristics.

The DSP block of UWB_TX(shown in the preceding block diagram) uses
other Signal Parameters .

 More control of Circuit Envelope analysis can be achieved by setting Envelope6.
controller parameters. These settings include Enable Fast Cosim, which may speed
the RF DUT simulation more than 10×. Setting these simulation options is described
in Setting Fast Cosimulation Parameters and Setting Circuit Envelope Analysis
Parameters in the Wireless Test Bench Simulation documentation.
After running a simulation, results will appear in a Data Display window for the7.
measurement. Simulation Measurement Displays (adswtbuwb) describes results for
each measurement. For general WTB Data Display details refer to Viewing WTB
Analysis Results (adswtbsim).
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 UWB_TX
  

This section provides parameter information for Required Parameters, Basic Parameters,
Signal Parameters, and parameters for the various measurements.

 
Description: UWB TX test
Library: WTB
Class: TSDFUWB_TX
Derived From: baseWTB_TX

 Parameters

Name Description Default Unit Type Range

RequiredParameters      

CE_TimeStep Circuit envelope simulation time step 1/528
MHz/2

sec real (0, ∞)

WTB_TimeStep Set CE_TimeStep<
=1/Bandwidth/2^OversamplingOption.

   

SourcePower Source power dbmtow(-
9.9)

W real [0, ∞)

FMeasurement Measurement carrier frequency 4224 MHz Hz real (0, ∞)

MeasurementInfo Available Measurements    

RF_EnvelopeMeasurement Enable RF envelope measurement?
NO, YES

YES  enum  

Constellation Enable constellation measurement?
NO, YES

NO  enum  

PowerMeasurement Enable power measurement? NO, YES NO  enum  

SpectrumMeasurement Enable spectrum measurement? NO,
YES

NO  enum  

EVM_Measurement Enable EVM measurement? NO, YES NO  enum  

BasicParameters      

SourceR Source resistance 50 Ohm Ohm real (0, ∞)

SourceTemp Source resistor temperature -273.15 Celsius real [-
273.15,
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∞)

EnableSourceNoise Enable source thermal noise? NO, YES NO  enum  

MeasR Measurement resistance 50 Ohm Ohm real [10,
1.0e6]

TestBenchSeed Random number generator seed 1234567  int [0, ∞)

SignalParameters      

GainImbalance Gain imbalance, Q vs I 0.0 dB real (-∞,
∞)

PhaseImbalance Phase imbalance, Q vs I 0.0 deg real (-∞,
∞)

OversamplingOption Oversampling ratio: Ratio 1, Ratio 2,
Ratio 4, Ratio 8, Ratio 16, Ratio 32

Ratio 2  enum  

DataPattern Data pattern: PN9, PN15, FIX4,
_4_1_4_0, _8_1_8_0, _16_1_16_0,
_32_1_32_0, _64_1_64_0

PN9  enum  

BandGroup BandGroup: BandGroup1,
BandGroup2, BandGroup3,
BandGroup4, BandGroup5,
BandGroup6

BandGroup1  enum  

DataRate Data rate: _53.3 Mbps, _55 Mbps, _80
Mbps, _106.67 Mbps, _110 Mbps,
_160 Mbps, _200 Mbps, _320 Mbps,
_400 Mbps, _480 Mbps

_53.3 Mbps  enum  

DataLength Octet number of PSDU 100  int [1,
4095]

PreambleFormat PLCP preamble format: Standard
Format, Burst Format

Standard
Format

 enum  

TFC_Number Time frequency code: TFC1, TFC2,
TFC3, TFC4, TFC5, TFC6, TFC7

TFC1  enum  

ScramblerSeed Scrambler seed selection: Seed 00,
Seed 01, Seed 10, Seed 11

Seed 00  enum  

RF_EnvelopeMeasurementParameters      

RF_EnvelopeDisplayPages RF envelope measurement display
pages:

   

RF_EnvelopeStart RF envelope measurement start 0.0 sec real [0, ∞)

RF_EnvelopeStop RF envelope measurement stop 0.5 µ sec real [0, ∞)

RF_EnvelopeSymbols RF envelope measurement OFDM
symbols

1  int [0,
1000]

ConstellationParameters      

ConstellationDisplayPages Constellation measurement display
pages:

   

ConstellationFrames Constellation measurement OFDM
frames

1  int [1, )

PowerMeasurementParameters      

PowerDisplayPages Power measurement display pages:    

PowerSymbolsMeasured OFDM symbols measured 3  int [1, ∞)

PowerOutputPoint Indicate output precision 100  int [1, ∞)

SpectrumMeasurementParameters      

SpecMeasDisplayPages Spectrum measurement display
pages:

   

SpecMeasStart Spectrum measurement start 0.0 sec real [0, ∞)

SpecMeasStop Spectrum measurement stop 0.5 µ sec real [0, ∞)
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SpecMeasSymbols Spectrum measurement OFDM
symbols

3  int [0,
100]

SpecMeasResBW Spectrum resolution bandwidth 0 Hz real [0, ∞)

SpecMeasWindow Window type: none, Hamming 0.54,
Hanning 0.50, Gaussian 0.75, Kaiser
7.865, _8510 6.0, Blackman,
Blackman-Harris

none  enum  

EVM_MeasurementParameters      

EVM_DisplayPages EVM measurement display pages:    

EVM_Delay EVM measurement delay 10 nsec sec real (0, ∞)

EVM_StartFrame EVM measurement start frame 1  int [1, ∞)

EVM_FramesToAverage Frames used for RMS averaging 1  int [1, ∞)

 Pin Inputs

Pin Name Description Signal Type

2 Meas_In Test bench measurement RF input from RF circuit timed

 Pin Outputs

Pin Name Description Signal Type

1 RF_Out Test bench RF output to RF circuit timed
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 Setting Parameters
More control of the test bench can be achieved by setting parameters in the Basic
Parameters , Signal Parameters , and measurement categories for the activated
measurements.

Note
For required parameter information, see the instruction Set the Required Parameters (adswtbuwb) under
UWB Transmitter Test.

  

 Basic Parameters

SourceR is the RF output source resistance.1.
SourceTemp is the RF output source resistance temperature (°C) and sets noise2.
density in the RF output signal to (k(SourceTemp+273.15)) Watts/Hz, where k is
Boltzmann's constant.
EnableSourceNoise, when set to NO disables the SourceTemp and effectively sets it3.
to -273.15°C (0 Kelvin). When set to YES, the noise density due to SourceTemp is
enabled.
MeasR defines the load resistance for the RF DUT output Meas signal into the test4.
bench. This resistance loads the RF DUT output; it is also the reference resistance for
Meas signal power measurements.
TestBenchSeed is an integer used to seed the random number generator used with5.
the test bench. This value is used by all test bench random number generators,
except those RF DUT components that use their own specific seed parameter.
TestBenchSeed initializes the random number generation. The same seed value
produces the same random results, thereby giving you predictable simulation results.
To generate repeatable random output from simulation to simulation, use any
positive seed value. If you want the output to be truly random, enter the seed value
of 0.

  

 Signal Parameters

GainImbalance, PhaseImbalance are used to add certain impairments to the ideal1.
output RF signal. Impairments are added in the order described here.
The unimpaired RF I and Q envelope voltages have gain and phase imbalance
applied. The RF is given by:

where A is a scaling factor that depends on the SourcePower and SourceR
parameters specified by the user, VI ( t ) is the in-phase RF envelope, VQ( t ) is the
quadrature phase RF envelope, g is the gain imbalance

and, φ (in degrees) is the phase imbalance.
OversamplingOption sets the oversampling ratio of UWB RF signal source. Options2.
from 0 to 6 result in oversampling ratio 2, 4, 8, 16, 32, 64 where oversampling ratio
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= 2 OversamplingOption . If OversamplingOption = 2, the oversampling ratio = 2 2 = 4
and the simulation RF bandwidth is larger than the signal bandwidth by a factor of 4
(e.g. for Bandwidth=528 MHz, the simulation RF bandwidth = 528 MHz × 4 = 2112
MHz).
For DataPattern:3.

if PN9 is selected, a 511-bit pseudo-random test pattern is generated according
to CCITT Recommendation O.153.
if PN15 is selected, a 32767-bit pseudo-random test pattern is generated
according to CCITT Recommendation O.151.
if FIX4 is selected, a zero-stream is generated.
if x_1_x_0 is selected (where x equals 4, 8, 16, 32, or 64) a periodic bit stream
is generated, with the period being 2 x. In one period, the first x bits are 1s and
the second x bits are 0s.

DataRate specifies the data rate 53.3, 55, 80, 106.67, 110, 160, 200, 320, 400 and4.
480 Mbps. When the DataRate is set, the data rate-dependent parameters such as
modulation, coding rate, conjugate symmetric Input to IFFT, time spreading factor,
overall spreading gain and coded bits per OFDM symbol (NCBPS) will be set according
to the specification. Please refer to the following table for details. Although there are
10 choices for parameter DataRate, only 8 of them are supported. The data rate 55M
bps and 106.7M bps are kept for future extension.

Data
Rate
(Mb/s)

Modulation Coding
rate
(R)

Conjugate
Symmetric
Input
to IFFT

Time
Spreading
Factor (TSF)

Overall
Spreading
Gain

Coded bits
per OFDM
symbol
(NCBPS)

53.3 QPSK 1/3 Yes 2 4 100

80 QPSK 1/2 Yes 2 4 100

110 QPSK 11/32 No 2 2 200

160 QPSK 1/2 No 2 2 200

200 QPSK 5/8 No 2 2 200

320 DCM 1/2 No 1 (No
spreading)

1 200

400 DCM 5/8 No 1 (No
spreading)

1 200

480 DCM 3/4 No 1 (No
spreading)

1 200

DataLength represents the bytes of PSDU (MAC frame body). Its value range is for 15.
to 4095 bytes.
PreambleFormat is used to select Standard PLCP or Shortened PLCP preamble format6.
defined in UWB-OFDM.
TFC_Number is for Time-frequency codes number, which controls the frequency7.
hopping sequence.
ScramblerSeed is to select the seed identifier. And the seed identifier controls 15 bit8.
initialization vector. Please note, the receiver has a fixed one frame delay. So, the
values of ScramblerSeed in UWB-OFDM signal source (UWB_SignalSource,
UWB_SignalSource_RF and UWB_Source_FH_RF) and receiver (UWB_Receiver,
UWB_Receiver_RF and UWB_Receiver_FH_RF) should be the two consecutive values.
Only above setting can get right BER (Bit Error Rate). For examples, ScramblerSeed
=Seed 00 in UWB-OFDM signal source; ScramblerSeed = Seed 11 in UWB-OFDM
receiver.
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 RF Envelope Measurement Parameters

Depending on the values of RF_EnvelopeStart, RF_EnvelopeStop, and
RF_EnvelopeSymbols, the stop time may be adjusted.

RF_EnvelopeDisplayPages provides Data Display page information for this
measurement. It cannot be changed by the user.
RF_EnvelopeStart sets the start time for collecting input data.
RF_EnvelopeStop sets the stop time for collecting input data when
RF_EnvelopeSymbols = 0.
RF_EnvelopeSymbols (when > 0) sets the number of symbols over which data will be
collected.

For RF envelope measurement for both the RF and Meas signals:

Let:

Start = TimeStep × (int(RF_EnvelopeStart/TimeStep) + 0.5)

Stop = TimeStep × (int(RF_EnvelopeStop/TimeStep) + 0.5)

This means Start and Stop are forced to be an integer number of time-step
intervals.

RF_EnvelopeSymbols Resultant Stop Time

0 Stop

> 0 Start + RF_EnvelopeSymbols x SymbolTime

For information about TimeStep, see Test Bench Variables for Data Displays.

  

 Constellation Parameters

ConstellationDisplayPages provides Data Display page information for this1.
measurement. It cannot be changed by the user.
ConstellationStartframe sets the start time for collecting the first frame data. The2.
ConstellationStartframe value can be set > 0 to avoid any start-up transient in the
Constellation plots.
Constellationframes sets the number of frames over which data will be collected.3.

The measurement start time is the time when ConstellationStartframe is detected in the
measured RF signal. The measurement stop time is this start time plus
Constellationframes × frameTime; frameTime is defined in Test Bench Variables for Data
Displays.

  

 Power Measurement Parameters

PowerDisplayPages provides Data Display page information for this measurement. It1.
cannot be changed by the user.
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PowerSymbolsMeasured (when > 0) sets the number of symbols over which data will2.
be collected.
PowerOutputPoint indicates the output precision.3.

The measurement start time is the time when the first frame is detected in the measured
RF signal. The measurement stop time is this start time plus PowerSymbolsMeasured ×
312.5 nsec.

  

 Spectrum Measurement Parameters

The Spectrum measurement calculates the spectrum of the input signal. Averaging the
spectrum over multiple bursts can be enabled as described in this section.

In the following, TimeStep denotes the simulation time step, and FMeasurement denotes
the measured RF signal characterization frequency.

The measurement outputs the complex amplitude voltage values at the frequencies1.
of the spectral tones. It does not output the power at the frequencies of the spectral
tones. However, one can calculate and display the power spectrum as well as the
magnitude and phase spectrum by using the dBm, mag, and phase functions of the
data display window.
Note that the dBm function assumes a 50-ohm reference resistance; if a different
measurement was used in the test bench, its value can be specified as a second
argument to the dBm function, for example, dBm(SpecMeas, Meas_RefR) where
SpecMeas is the instance name of the spectrum measurement and Meas_RefR is the
resistive load.
By default, the displayed spectrum extends from FMeasurement - 1/(2 × TimeStep)
Hz to FMeasurement + 1/(2 × TimeStep) Hz. When FMeasurement < 1/(2 ×
TimeStep), the default spectrum extends to negative frequencies. The spectral
content at these negative frequencies is conjugated, mirrored, and added to the
spectral content of the closest positive frequency. This way, the negative frequency
tones are displayed on the positive frequency axis as would happen in an RF
spectrum analyzer measurement instrument. This process may introduce an error in
the displayed frequency for the mirrored tones. The absolute error introduced is less
than (Spectrum Frequency Step) / 2 (refer to the "Effect of Values" table for the
definition of Spectrum Frequency Step).
The basis of the algorithm used by the spectrum measurement is the chirp-Z
transform. The algorithm can use multiple bursts and average the results to achieve
video averaging.
SpecMeasDisplayPages is not user editable. It provides information on the name of2.
the Data Display pages in which this measurement is contained.
SpecMeasStart sets the start time for collecting input data.3.
SpecMeasStop sets the stop time for collecting input data when SpecMeasSymbols =4.
0 and SpecMeasResBW = 0.
SpecMeasSymbols sets the number of symbols over which data will be collected when5.
SpecMeasSymbols>0.
SpecMeasResBW sets the resolution bandwidth of the spectrum measurement when6.
SpecMeasResBW>0.
Depending on the values of SpecMeasStart, SpecMeasStop, SpecMeasSymbols, and
SpecMeasResBW, the stop time may be adjusted or spectrum video averaging may
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occur (or both). The different cases are described in the table below.
 

 Effect of Values for SpecMeasStart, SpecMeasStop, SpecMeasSymbols, and SpecMeasResBW

Case
1

SpecMeasSymbols = 0
SpecMeasResBW = 0
Resultant stop time = Stop
Resultant resolution BW = NENBW/(Stop - Start)
Resultant spectrum frequency step = 1/(Stop-Start)
Video averaging status = None

Case
2

SpecMeasSymbols > 0
SpecMeasResBW = 0
Resultant stop time = Start + SpecMeasSymbols x SymbolTime (Notes: For SpecMeasSymbols >
0 and SpecMeasResBW = 0. Video averaging occurs over all symbol time intervals.)
Resultant resolution BW = NENBW /SymbolTime
Resultant spectrum frequency step = 1/SymbolTime
Video averaging status = Yes, when SpecMeasSymbols > 1

Case
3

SpecMeasSymbols = 0
SpecMeasResBW > 0
Resultant stop time = Start + N x SymbolTimeInterval
where
N = int((Stop -Start)/SymbolTimeInterval) + 1
For SpecMeasSymbols = 0 and SpecMeasResBW > 0
Define SymbolTimeInterval = TimeStep x int((X/SpecMeasResBW/TimeStep) + 0.5)
This means SymbolTimeInterval is forced to a value that is an integer number of time step
intervals.
(Stop-Start) time is forced to be an integer number (N) of SymbolTimeIntervals
N has a minimum value of 1
Video averaging occurs over all SymbolTimeIntervals
The resolution bandwidth achieved is ResBW = NENBW / SymbolTimeInterval, which is very close
to SpecMeasResBW but may not be exactly the same if NENBW/SpecMeasResBW/TimeStep is not
an exact integer.
Resultant resolution BW = ResBW
Resultant spectrum frequency step = ResBW
Video averaging status = Yes when N > 1

Case
4

SpecMeasSymbols > 0
SpecMeasResBW > 0
Resultant stop time = Start + M x SymbolTimeInterval
where
M = int((SpecMeasSymbols x SymbolTime)/SymbolTimeInterval) + 1
For SpecMeasSymbols > 0 and SpecMeasResBW > 0
Define SymbolTimeInterval = TimeStep x int(( NENBW /SpecMeasResBW/TimeStep) + 0.5)
This means SymbolTimeInterval is forced to a value that is an integer number of time step
intervals.
(Stop-Start) time is forced to be an integer number (M) of the SymbolTimeIntervals
M has a minimum value of 1
Video averaging occurs over all SymbolTimeIntervals
The resolution bandwidth achieved is ResBW = NENBW / SymbolTimeInterval, which is very close
to SpecMeasResBW but may not be exactly the same if X/SpecMeasResBW/TimeStep is not an
exact integer.
Resultant resolution BW = ResBW
Resultant spectrum frequency step = ResBW
Video averaging status = Yes, when M > 1

Referring to the table, let

Start = TimeStep × int((SpecMeasStart/TimeStep) + 0.5)
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Stop = TimeStep × int((SpecMeasStop/TimeStep) + 0.5)

(This means Start and Stop are forced to be an integer number of time step
intervals.)

NENBW = normalized equivalent noise bandwidth of the window

Equivalent noise bandwidth (ENBW) compares the window to an ideal, rectangular
filter. It is the equivalent width of a rectangular filter that passes the same amount of
white noise as the window. The normalized ENBW (NENBW) is ENBW multiplied by
the duration of the signal being windowed. The "Window Options" table lists the
NENBW for the various window options.
The Start and Stop times are used for both the RF and Meas signal spectrum
analyses. The Meas signal is delayed in time from the RF signal by the value of the
RF DUT time delay. Therefore, for RF DUT time delay greater than zero, the RF and
Meas signal are inherently different and some spectrum display difference in the two
is expected.
TimeStep is defined under Test Bench Variables for Data Displays.
SpecMeasWindow specifies the window that will be applied to each burst before its7.
spectrum is calculated. Different windows have different properties, affect the
resolution bandwidth achieved, and affect the spectral shape. Windowing is often
necessary in transform-based (chirp-Z, FFT) spectrum estimation in order to reduce
spectral distortion due to discontinuous or non-harmonic signal over the
measurement time interval. Without windowing, the estimated spectrum may suffer
from spectral leakage that can cause misleading measurements or masking of weak
signal spectral detail by spurious artifacts.
The windowing of a signal in time has the effect of changing its power. The spectrum
measurement compensates for this and the spectrum is normalized so that the power
contained in it is the same as the power of the input signal.
Window Type Definitions:

none:

where N is the window size
Hamming 0.54:

where N is the window size
Hanning 0.5:

where N is the window size
Gaussian 0.75:
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where N is the window size
Kaiser 7.865:

where N is the window size,  α = N / 2, and I0(.) is the 0th order modified
Bessel function of the first kind
8510 6.0 (Kaiser 6.0):

where N is the window size,  α = N / 2, and I0(.) is the 0th order modified
Bessel function of the first kind
Blackman:

where N is the window size
Blackman-Harris:

where N is the window size.
 

 Window Options and Normalized Equivalent Noise Bandwidth

Window and Default Constant Normalized Equivalent
Noise Bandwidth (NENBW)

none 1

Hamming 0.54 1.363

Hanning 0.50 1.5

Gaussian 0.75 1.883

Kaiser 7.865 1.653

8510 6.0 1.467

Blackman 1.727

Blackman-Harris 2.021
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 EVM Measurement Parameters

The EVM measurement is used to measure the EVM of UWB RF signal source with
frequency hopping used, and needs no reference signal provided by the source.

EVM_DisplayPages provides Data Display page information for this measurement. It1.
cannot be changed by the user.
EVM_StartFrame sets the start frame for collecting input data.2.
EVM_FramesToAverage sets the frame number used for averaging.3.
EVM_Delay sets EVM measurement delay.4.

  



Advanced Design System 2011.01 - UWB Wireless Test Benches

66

 Simulation Measurement Displays
After running the simulation, results are displayed in Data Display pages for each
measurement activated.

Note
Measurement results from a wireless test bench have associated names that can be used in Data Display
Expressions. For more information, refer to Measurement Results for Expressions for UWB Wireless Test
Benches (adswtbuwb).

 

 Envelope Measurement

 The Envelope measurement shows the envelope and spectrum of each field in the UWB
frame (PLCP preamble, PLCP header, and DATA fields). Two signals are tested, the RF
source signal at the RF DUT input and the Meas signal at the RF DUT output.

For envelope measurement, the default parameter setting is given in the following table.

Parameter Default Setting

RF_FSource 3960.0 MHz

RF_R 50.0 Ohm

PreambleTime 9.375 usec (standard
format)

HeaderTime 3.75 usec

OFDM_SymbolTime 312.5 nsec

frameTime 30.0 usec

TimeStep 0.473 nsec

BitRate 53.3 Mbps

Meas_FMeasurement 3960.0 MHz

Meas_R 50.0 Ohm

For the RF signal, the time domain envelope and spectrum of one complete UWB frame,
as well as preamble, header, and DATA fields are shown in the following eight figures.

 

 

 Time Envelope of UWB RF Signal for Default Settings (one frame)
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 Spectrum of UWB RF Signal

RF Signal PLCP preamble Envelope shows the Preamble is 9.375 µ lasting from 0 to 9.375
µ. The spectrum is shown in RF Signal PLCP preamble Spectrum.

 

 RF Signal PLCP preamble Envelope

 

 RF Signal PLCP preamble Spectrum
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RF Signal PLCP Header Envelope shows Header is 3.75 µ lasting from 9.375 to 13.125 µ.
The spectrum is shown in RF Signal PLCP Header Spectrum.

 

 RF Signal PLCP Header Envelope

 

 RF Signal PLCP Header Spectrum

RF Signal DATA Envelope shows Data is 16.875 µ lasting from 13.125 to 30.0 µ. The
spectrum is shown in RF Signal DATA Spectrum.

 

 RF Signal DATA Envelope
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 RF Signal DATA Spectrum

For the Meas signal test, all measurements are the same as RF signal measurements,
except the Meas signal will contain any linear and nonlinear distortions. Envelope and
spectrum measurements for Meas signal are shown in the following eight figures.

 

 Time Envelope of UWB Meas Signal for Default Settings (one frame)

 

 Spectrum of UWB Meas Signal
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Meas Signal PLCP preamble Envelope shows the Preamble is 9.375 µ lasting from 0 to
9.375 µ. The spectrum is shown in Meas Signal PLCP preamble Spectrum.

 

 Meas Signal PLCP preamble Envelope

 

 Meas Signal PLCP preamble Spectrum

Meas Signal PLCP Header Envelope shows Header is 3.75 µ lasting from 9.375 to 13.125
µ. The spectrum is shown in Meas Signal PLCP Header Spectrum.

 

 Meas Signal PLCP Header Envelope
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 Meas Signal PLCP Header Spectrum

Meas Signal DATA Envelope shows Data is 16.875 µ lasting from 13.125 to 30.0 µ. The
spectrum is shown in Meas Signal DATA Spectrum.

 

 Meas Signal DATA Envelope

 

 Meas Signal DATA Spectrum
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 Constellation Measurement

 The constellation measurement shows the RF and Meas signal constellations.

According to Reference 1, only QPSK modulation is implemented. The default data rate of
53.3 Mbps is used for this measurement.

 Default Constellation Measurement Parameters

Parameter Default Setting

RF_FSource 3960.0 MHz

RF_R 50.0 Ohm

frameTime 30.0 usec

TimeStep 0.473 nsec

BitRate 53.3 Mbps

Meas_FMeasurement 3960.0 MHz

Meas_R 50.0 Ohm



Advanced Design System 2011.01 - UWB Wireless Test Benches

73

 

 RF Signal Constellation

 

 Meas Signal Constellation
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 Power Measurement

 The power measurement shows the CCDF curves of the transmitter and peak-to-average
ratios for the RF and Meas signals.

The basic power measurement parameters are listed in the following table.

Parameter Default Setting

RF_FSource 3960.0 MHz

RF_R 50.0 Ohm

Meas_FMeasurement 3960.0 MHz

Meas_R 50.0 Ohm

RF_Power_dBm -9.9 dBm

CCDF measurement results for RF and Meas signals are shown in RF Power CCDF and
Meas Power CCDF.

Reference CCDF measurements for Gaussian noise can be calculated by calling the
function power_ccdf_ref () in the. dds files directly, as shown in RF Power CCDF.

 

 RF Power CCDF

 

 Meas Power CCDF
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Functions for calculating peak-to-average-ratios and results are shown in RF Signal Peak-
to-Average-Ratio and Results and Meas Signal Peak-to-Average-Ratio Results.

 

 RF Signal Peak-to-Average-Ratio and Results

 

 Meas Signal Peak-to-Average-Ratio Results

 

 Spectrum Measurement

 The Spectrum measurement is used to verify that the transmitted spectrum meets the
spectrum mask according to Reference 1. The transmitted spectrum shall have a 0 dBr
(dB relative to the maximum spectral density of the signal) bandwidth not exceeding 260
MHz, -12 dBr at 285 MHz frequency offset, -20 dBr at 330 MHz frequency offset and
above. The transmitted spectral density must fall within the spectral mask, as shown in
Transmit Spectrum Mask.
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 Transmit Spectrum Mask

RF Signal Spectrum and Meas Signal Spectrum show the power spectrum density of the
UWB multi-band signals. Measurement results for RF and Meas signals at Band 2, together
with the FCC mask, are shown in RF Signal Spectrum for Band 2 and Meas Signal
Spectrum for Band 2. The RF and Meas signal spectrums are within the spectrum mask
and therefore meet specification requirements.

 

 RF Signal Spectrum

 

 Meas Signal Spectrum
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 RF Signal Spectrum for Band 2

 

 Meas Signal Spectrum for Band 2

 

 EVM Measurement
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The EVM measurement is a modulation accuracy measurement. Basic parameters for this
measurement are listed in the following table.

Parameter Default Setting

RF_FSource 3960.0 MHz

RF_R 50.0 Ohm

frameTime 30.0 usec

TimeStep 0.473 nsec

BitRate 53.3 Mbps

Meas_FMeasurement 3960.0 MHz

Meas_R 50.0 Ohm

EVM measurement results shown in RF Signal EVM and Meas Signal EVM for the 54 Mbps
data rate do not exceed -25 dB; therefore the measurements meet the specification
requirements.

 

 RF Signal EVM

 

 Meas Signal EVM

 

 Test Bench Variables for Data Displays

Variables listed in the following table are used to set up this test bench and data displays.
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Data Display
Parameter

Equation with Test Bench Parameters

RF_FSource FSource

RF_Power_dBm 10*log10(SourcePower)+30

RF_R SourceR

TimeStep 1/Bandwidth/(2^OversamplintOption)

N_Sym_Preamble Number of OFDM symbols in preamble. Standard preamble: 30; Shortened preamble:
18

N_Sym_Header Number of OFDM symbols in header after time-domain spreading. N_Sym_Header=12

UsefulBits DataLength*8+32+6

N_Sym_Data Number of OFDM symbols in PSDU before time-domain spreading.
N_Sym_Data=6/TSF*ceil(ceil(UsefulBits/CodingRate)/(6/TSF*N_CBPS))

SymbolsPerFrame N_Sym_Data*TSF+N_Sym_Header+N_Sym_Preamble

DataTime OFDM_SymbolsPerframe*OFDM_SymbolTime

FrameTime T_Sym*SymbolsPerFrame

BitRate Dependent on DataRate

Meas_FMeasurement FMeasurement

Meas_R MeasR
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 Baseline Performance
Test Computer Configuration

Pentium IV 2.26 GHz, 1024 MB RAM, Windows 2000
Conditions

Measurements made with default test bench settings.
RF DUT is an RF system behavior component.
Length of one UWB frame is a function of Bandwidth, OversamplingOption,
IdleInterval, GuardInterval, DataRate, and DataLength.
Bandwidth = 528 MHz
OversamplingOption = 2 for Ratio 4
IdleInterval=0 µ
T_Sym=312.5 nsec
CyclicPrefix=70.08 nsec
GuardInterval = 0.0 nsec
DataRate = 53.3 Mbps
DataLength = 100
Resultant WTB_TimeStep = 0.473 nsec; frameTime = 30 µ

Simulation times:
UWB_TX Measurement Simulation Time (sec) ADS Processes(MB)

RF_Envelope 681 122

Constellation 676 122

Power 1300 165

Spectrum 689 122

EVM 676 122

 

 Expected ADS Performance

Expected ADS performance is the combined performance of the baseline test bench and
the RF DUT Circuit Envelope simulation with the same signal and number of time points.
For example, if the RF DUT performance with Circuit Envelope simulation alone takes 2
hours and consumes 200 MB of memory (excluding the memory consumed by the core
ADS product), then add these numbers to the Baseline Performance numbers to
determine the expected ADS performance. This is valid only if the full memory consumed
is from RAM. If RAM is less, larger simulation times may result due to increased disk
access time for swap memory usage.
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Setting up a Wireless Test Bench Analysis in the Wireless Test Bench Simulation
documentation explains how to use test bench windows and dialogs to perform
analysis tasks.
Setting Circuit Envelope Analysis Parameters in the Wireless Test Bench Simulation
documentation explains how to set up circuit envelope analysis parameters such as
convergence criteria, solver selection, and initial guess.
Setting Automatic Behavioral Modeling Parameters in the Wireless Test Bench
Simulation documentation explains how to improve simulation speed.
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